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Chapter 1 — System Overview

Understanding user types

There are three types of users: Diversity Users, Project Managers/Buyers, and Vendor Users.
Diversity Users and Project Managers/Buyers are both for staff, but the Project
Manager/Buyer account is designed for strictly view-only access to records. The accessible
records and transactions depend on your account type.

A Diversity User can:

e Add vendors and edit vendor information.
e Access and edit contracts, concessions, certifications, and audit information.
e Create new contracts, concessions, insurance certificates, and outreach projects.

A Project Manager/Buyer can:

e View contract records and audit information.
e Add vendors and edit vendor information.

A Vendor user can:

e Update their contact information.
e Provide subcontractor payment data for contract audits.
e Provide revenue and payment data for concession audits.

Understanding notification types

The system automatically generates several types of user notifications:

Username/password reminder, password change, and account registration notices.
Contract/concession/insurance audit notices.

Unresponsive subcontractor/supplier/subtenant notices.

Audit discrepancy notices.

Outreach notices.

Some notifications may require a response, which are typically received by B2Gnow Support.
There may be times when B2Gnow cannot address the issue. In these circumstances,
B2Gnow forwards the message to a member of your staff, usually the Compliance Officer or
Certification Officer. Please take the appropriate actions to resolve any user issues.
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Understanding user roles for diversity users

The description for the user’s accessibility defines the user roles. B2Gnow configures the
roles with specific access rights to match the functions of your staff.

User Roles @

Name Description Assigned Users Actions

Administrator Full system access 12 Edit
Delete

Certification Officer Certification Officer 6 Edit
Delete

@ Certification Officer - Advanced  All certification functions 1 Edit
Delete

Consultant Access Role for external consultants to access system 1 Edit
data and reporting. Delete

Contract Compliance Officer Contract Compliance Officer 22 Edit
Delete

Contract/Concession Compliance Contract/Concession Compliance Officer 1 Edit
Officer Delete

Staff Administrator Full access to all staff functions. 2 Edit
Delete

@ User Standard user with standard access. 26 Edit
Delete

View Only User View only access to records. as Edit
Delete

Getting started

To access the system, you require a user name and password. B2Gnow may have created an
account for you during implementation, or you can contact B2Gnow Support to have a new
account configured.

NOTE: Your organization may require a procedure to be followed to approve your request for
access. Please ask your supervisor or department director for more information.

To retrieve your log in information from the system home page

1. Inthe System Access Login box, click Forgot Password.
2. Enter your email address, user name, or user number.

Password Reminder

Enter your email address, username, or user number in the box below and we will send your password to
your registered e-mail address or fax number. If you do not know your username, you can look it up.

Submit
3. Click Submit.

An email and/or fax user name/password reminder will be sent to you within minutes. In
most cases, your user name is your email address.

Page 1-2 © B2Gnow
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Logging in for the first time

Once you receive your user name and password you are ready to get started.

Tologin

1. Inthe Username and Password fields, enter your user name and password.

2. Click Login.

System Access Login
Username:

Passward:

Login

The Welcome page displays introductory information for your benefit.

© B2Gnow
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Senen )
Home
Yiew »

Search »
Reporting Tools »
Contract Mgmt »

Concession Mgmt »
Tools »
Message »
Edit Settings »
Help & Support »
System »
Logoff

Show Al Hide All
Logged on as

Zonia Davila,
City of Houston

- Welcome to our system! _

Qur system is designed to make data gathering simplier and faster. Please review the information below before continuing to ensure that you
maximize the power of this tool

Security
» Change your password immediately if someone else set up your account,

» Do notuse someone else's account, Every person must have their own account. fyouw do not know how to set up a user account, please
contact us through the messaging system: from the left menu, click Message, then Contact System Support

Navigating
» All system functions are available from the menu on the left Just click any of the topics to view the subitems. This menu is visible at all imes

» The page you will see afier this welcome screen is your dashboard. It provides a quick summary of your assigned records and alerts you it
immediate action is required.

Finding Records
» Ifyou need to find a paticular record {contract, vendor, user, cerification), the best place 1o stan is Search, From the left menu, click Search,
then select the type of record you need fo find. For fips on searching the system, download the Quick Guide listed below

Help & Support
» Download support guides in PDF farmat. Staff should use the Staff Quick Guide Any users that deal with vendors an a regular basis should
also view the Vendor Quick Guide and Customer Support Guide:

» More help options are available from the left menu under Help & Support, including our online help system, a Forums module, and

messaging tools.
Do not show this page again, Continue |
‘.

Heme | Help | Print This Page

Lustomer Service
Copyright @ 2006 B2Gnow. All rights rasarved,

=

Review the information on this page. There are several useful PDFs available for download
from the Help & Support area. You can download the Staff Quick Guide, the Vendor Quick
Guide, and the Customer Support Guide. You can use these guides as a quick reference to the

system.

Click the checkbox to not display the page on future logins.
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Viewing the Home page & Dashboard

SYSTEM OVERVIEW

After clicking Continue on the Welcome page, the system home page displays. From this

page, you can access every feature your user role permits.

Search »
Reporting »
Create »
Tools »
Settings »

Help & Support »
Logoff

Show All

Hide All

Your Dashboard

wiew data dashboard
My Contract Audits Last 30 Last 3
[Hide] days months

Mo active records

My Support

Total Fud
[Hide] otal < ays

Mo active records

My Vendors Incomplete Submitted
[Hide] <32 mo < 2 mo
Vendor Questionnaires 13 32
My Contracts and

Concessions
My Concession Audits
My Outreach

My Certification
Applications

My Certifications

Click Hide or View to configure your dashboard.

=]

Last 12
months

Alerts

View All Alerts Deactivate Displayed
Alerts

Contract 4600007122: 3/10/12 View
Payments to Subs Deactivate
reported
Contract 4600009916: 8/10/12 Miew
Confirm payments to Deactivate
sub

System News
New Features released June 30. Lots
of new items -- features noted with ¥

require configuration to activate.

General

Users can use vendor guick
search options for one click
access to the directory.
Integration with Outlook
Calendar: from a certification.
contract, or vendor comment
click the Add to Calendar link
to add a trigger reminder in
Outlook for your comment. On
an event after reserving a
space, the same process can
be used to create a reminder
on your own computer.

+ Implemented configurable
options to control user
password strength.*
Implemented new POF tool for
printing web pages.

New Features released April 15
= Wigw More

B2Gnow Training Classas
# Miew Mare

Configure

Change Your
Bassword

© B2Gnow
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Using the Dashboard

Your Dashboard

My Contracts and Concessions
[Hid=]

No records assigned

My Concession Audits
[Hide]

No active records

My Certification Applications
[Hide]

Total Apps
DEE New

MEE/WEE/DBE/SEE/FDBE NCA
MEE/WEBE/SBE/PDEE New
SBE New

SEE NCA

My Vendors
[Hide]

vendeor Questionnaires
My Contract Audits
My Support
My Outreach
My Certifications

Last 30
days

Pending
Submission

|U'I |I\J [f=]

Incomplete
< 3 mo

1s

Click Hide or View to configure your dashboard.

view data dashboard El

Contracts Concessions

Last 3 Last 12
manths manths
Pending Panding
Receipt Processing

Elec Paper

1o 38 S0
1 & A
8 7 38
i 21 z
o 3 z
o 1 A

S”'imsftt;g Active
32 445

View

View

Wiew

Wiew

SYSTEM OVERVIEW

The Dashboard provides a
snapshot of your records
and transactions. ltemsin
red indicate the need for
immediate attention. To
view a list of issues, click
the red number.

To configure your
dashboard, click Hide or
View. Your configuration
automatically saves each
time you view the
Dashboard.
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Exploring the navigation menu
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SYSTEM OVERVIEW

The left navigation menu provides access to all functions in
the system. Click the main categories to open additional sub-
items. Click sub-items to access the selected function in the
right display window.

= = ¢4 S

Home

View »
Search »
Reporting »
Create »
Tools »
Settings »
Help & Support »
Logoff

Show All Hide All

Performing searches

NOTE: When new functions are added to the system, the menu may
be extended or rearranged.

Using various search options and methods, you can search for specific information in the

system.

Searching for basic information

To search for information

1. From the Search menu, select a search option.
2. Inthe Search Parameters area, enter the search criteria.
3. Click Search First 20 Matches for a quick set of results or Search All Matches for a full

set.

© B2Gnow
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Understanding search types

SYSTEM OVERVIEW

User Search — Search for specific individuals in the system. You can search the entire system

to find a vendor contact, project manager/buyer, or diversity user. You can search by

company or organization, name, email address, or phone number.

Users | Vend’ursl Cuntradsl Cuncessiunsl 0utreach|

Enter search parameters and click Search. The more specific the terms, the more limited the results. If unsure about the exact name of a p¢

Search First 20 Matches Search All Matches Clear Form

Search Parameters

Organization

First Name

Last Name

User Type Buyer
Diversity user
‘Vendor

User Number

Email

Vendor Search — Search for a specific vendor in the system. You can complete a simple

search by name or an expanded search for vendors with specific certifications and commodity

codes.

If your organization uses the system to certify vendors or has access to a certified directory,

you can use certification details in the search.

Usersl Vendursl Cuntradsl Cuncesslunsl Uutreacnl

Search forvendors using their names, locations, classifications, ratings, andlor other criteria. Enter information into any of the boxes below and click Se

Search First 20 Matches Search All Matches Clear Form

Quick Search Options
Click a button to initiate an immediate search

Certified Directory Registered Firms

Search Parameters

Business Name/DBA
Contact Person First Last:
City
U.5. States/Provinces Canadian Provinces
State/Province E o |z|

U.S. Zip Code Canadian Postal Code

Zip Code/Postal Code

Phone Area Code

NAICS Code [cBEE:]]

Business Description

Certification Parameters

Certifications

e Match ANY certification type selected below E

Page 1-7
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Contract/Concession/Outreach Project/Insurance Search — Search for a reference number or
title associated with a record. You can use advanced search parameters to locate the record.

Usersl Venﬂnrs' Contracts I Cnncessinnsl Outreacnl

Search your organization’s contract database. Enter information into any of the boxes below and click Search. Some parameters are required.

Search First 20 Matches Search All Matches Clear Form

Search Parameters

ContractReference Number
{Contract number, financisl system reference, project number)

Contract Title

Containing Text
(Contract description. summary, notes, comments)

Contractor
@ Prime Subcontractor Either

Buyer/Project Manager
{Crganizstion name, contact name)

Contract Compliance Officer IMone selected |Z|

Search First 20 Matches Search All Matches Clear Form

Additional Search Parameters

Diversity Goal From % to % {enter values into either/both field(s))
Assigned Department Mone selected |Z|

Contract Type Mone selected E

Contract Category Mone selected

Tips for performing searches

You can search for information based on the parameters that you set. To create a search
string, keep the following tips in mind:

e Start with one parameter. Usually you can find the record you are looking for by using
one or two parameters. The more specific your search terms, the less likely you are to
find the record because of spelling, order, or other variations in your search.

o Keep search parameters short. Use “ACME” instead of “ACME Construction, Inc.” You
can even use partial words, such as “envi” instead of “environmental consultant.”

e The system ignores punctuation. C. C. is the same as C C; C & Cis treated the same as
CandC.

e Become familiar with possible settings and options. A record may not display
because you selected the wrong option. Narrow the search parameters to prevent
returning too many items in your search results.

e When searching for businesses named for their founder, such as John Smith & Co., the
record may be listed under “John Smith and Co.” or “Smith, John and Co.” You may
need to search for both versions. Start by searching for one of the names, such as
Smith.

e Searches are not case sensitive. ACME is treated the same as acme.

Page 1-8 © B2Gnow
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e When searching by first name, be aware that users may be listed by alternate names.
For example: James, Jim, Jimmy, or J.

e When searching by contract or project number, you must enter the number in the
exact order. However, it does not have to be complete (for example, enter C53 to
view all contracts that have C53 in the contract number, such as C531, C532, C53B, or
C53980). If you enter the sequence out of order, you will not find the record you are
looking for (C53 will not find C35).

Configuring your settings

Changing your password

The first time you log in to the system, you may be required to change your password.
To change your password

1. From the Settings menu, click Change Password.
2. Inthe Old Password field, enter your old password.
3. Inthe New Password and Type New Password Again fields, enter your new password.

Configuration Settings: Change Password Help & Tools 3§

Maintaining a secure password is central to the security and confidentiality of your data. To change your passwaord, enter a new password below.
All passwords must conform to the following requirements:

Password requirements:

+ Password must be at least & characters long.
Create a password thatis easyto remember, but difficult for others to guess. Do not make your password the same as your username or
vour first or last name, as these are too easy for an intruder to guess. Mever share your passwaord with anyone else. If another personin
your organization needs access to the system, please contact us for an additional user account.

‘When you change your password, you will receive a confirmation message. You can also contact Customer Support to get your password
reset.

* required entry

Old Password *
New Password *

Type New Password Again *

Save

4. Click Save.

Your new password is effective immediately. You may also receive an email confirmation of
the change.

© B2Gnow Page 1-9
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Editing your settings

Depending upon your access permissions, you may be able to update your account settings.
To update your account settings

1. From the Settings menu, open the Your Settings sub-menu.
2. Select the settings area you want to update.

3. Edit the fields as needed.

4. Click Save.

In the following example, User Information settings are displayed. You can open options by
clicking the settings area in the navigation menu or by clicking the tab.

. ' * Configuration Settings: User's Contact Information

Useriame—Admin

@tﬂc‘t Info |Addresse5| Preferencesl NUtiﬂcatiuns' Wurkﬂuwl Featurs Access'

AdJUSTYOUT USET Contact information Using te NMelds Delow. CICk save 1o confirm your changes.

* required entry

User Information ?

Username/Email * admin?@b2gnow_com
Verd User ID Number 30000001-004
endors
Certified Vendors
Users
Contracts Name * (First, Middle Initial, Last) Admin7

Concessions

Outreach Campaigns
| Certification Apps

Search Results »

Title

Reporting » Phone * 713 8379027 Ext
| Create » Fax * 713 837-9050

Tools » ‘Jivsion

lS&Iﬁngs»

|
aanga = Save Cancel
our Settings »

Contact Info

Addresses

Prefarences

Notification Settings
Workflow
2atura Access

On the Addresses tab, you specify the address(es) you want to use for your mailing address,
which is where your mail is delivered; your billing address, which is the address you use for
billing information; your shipping address, which is where any packages are delivered; and
your physical address, which is the physical location of your office. They may be the same.
Contact B2Gnow Support if you need to add an address to the list.

Contact Info = Addresses |Preferences| Nntiﬁcatmnsl Wnrkﬂnw' Feature Access'

Adjust your address settings using the fields below. Click Save to confirm your changes. The Reset Settings button restores your address
settings to the default for the organization.

* required entry

Default Addresses

Mailing * [Default] : P.O. Box 1562, Houston, TX .. |Z|
Billing * [Default] : P.O. Box 1562, Houston, TX ... |Z|
Shipping * [Default] : 611 Walker Street, 7th Floor, Houston, ... |Z|
Physical * [Default] - 611 Walker Street, Tth Floor, Houston, ... |Z|

© B2Gnow
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On the Preferences tab, you can set the time zone for your location and specify your
preferred language.

Cuntad\nfUIAddresses Preferences | Notifications | Workflow | Feature Access

Adjust your user preferences using the fields below. Click Save to confirm your changes.

* required entry

Account Settings ?
Time Zone * US/Central |Z|

On the Notifications tab, you specify the way in which you want to receive notifications from
the system.

Contact Info | Addresses | Preferences NDTIﬂCﬂilﬂﬂsl‘a'durkﬂnw Feature Access

Adjust your notification preferences using the fields below. Click Save to confirm your changes.

* required entry

Notification Delivery

Preferred Notification Method Email AND Fax: Send me plaintext email  [~]
@ Email: Send me plain-text email |Z|
Fax

Dont send any messages. All messages will be read when logged into the system

On the Workflow tab, you set assigned department and user hierarchy. If a user is assigned
to a specific department, they can only view contracts and related records from that
department. Otherwise the user can view all records maintained by your organization.

Cnntactlnfn' Ad’d’resses' Preferencesl Motifications  Workflow |FeatureAccess|

Adjust your workflow settings using the fields below. Click either ofthe Save buttons to confirm your changes.

* required ent

User Settings

Select and assign to limit user to that department's contracts

Assign Department — Select a department |Z| Assign

Assigned Departments User can access records assigned to all departments.

Save Cancel

User's Manager 9 Mone
(Pick only one)

Admin7, Houston
User?, Houston
Userd, Houston

On the Feature Access tab, view the user’s role for accessing the system.

Contact Info | Adaresses | Preferences | Notfications | Workfiow | Feature Access |

Adjust your user role settings using the fields below. Click Save to confirm your changes.

User Roles

Administrator AdministratorAccess

@ Contract Compliance & Workforce Contract Compilliance & Workforce. Ability to manage staff user accounts

View Only View Contracts and Workforce. This user cannot create or edit contracts or workforce reports.

Save Cancel

© B2Gnow Page 1-11
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Sending messages

Page 1-12

The system includes the ability to send email messages to other users. It is an easy way for
Compliance or Certification Officers to contact vendors about an issue without having to use
an external email program. Vendors also communicate with each other. The sent message is
saved, providing a detailed transaction and audit history.

Contacting Support

If you need assistance, you can contact System Support.

To contact support

1.
2.

Open the Help & Support menu, and then click Contact Support.

In the Message Subject field, enter a description of the issue for which you want to
contact support.

In the Message field, enter the message.

Click Save/Send.

Messaging: Send a Message to Customer Support

Senda Messagel Contact Support | Submit Feedbackl Report a Prublem'

Use this page to send a message to a customer support. You can attach afile if needed

Ifyou are reporting an issue and it is related to a a particular record, or there are examples that can be reviewed by customer support, please
provide this information to reduce the time ittakes to review and resolve the situation

* required entry
Message Subject *

Message *

Attach File Aftach File

Spell Check Save/Send Cancel

© B2Gnow
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To report a problem

If you experience an unexpected issue with the system, please report the problem to

SYSTEM OVERVIEW

customer support by clicking the Report a Problem tab. When reporting an issue, enter
specific information. The more information you give to us about the problem, the faster we

can address the issue. Tell us what you were doing and what links you clicked. When
applicable, please attach a screenshot of the page.

Messaging: Compose Problem Report
Send a Message | Contact Support | Submit Feedback | Report a Problem |

Use this form to report problems with the system

Fill in as much information as possible and use the additional information box to describe how the problem occurred. You can attach any
documentation or a screen capture of the problem (hit the PriScn key and paste into a Word document).

Ifthe issue is with a paricular record, or there are examples that can be reviewed, please provide this information to reduce the time it takes

to review and resolve the situation.

* required entry

Page Name *
Date of Problem *

Time of Problem

What you were doing at the time?

Describe the Problem

Additional Information

Attach File

© B2Gnow
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To capture a screenshot

1. Click the Print to PDF link at the bottom right of the page, or
2. Press and hold the Alt key, and then press the Print Screen key.

. & eJe)e] E‘D[‘BE]E] IIE]E] B==

= B B
ELL LT L ELE LT SRS @llD
il O 0 0 waa
a0 a0 8 Q0]
e — o [0 0]

3. Release the keys.

4. In Microsoft Word, paste the image into a new document, and then save the
document.

To attach a file

1. When composing your message, click Attach File.
2. Locate and open the file.
3. Click Attach File.

Page 1-14 © B2Gnow
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Sending messages to other users

You can send email or fax messages to other users, depending on their user settings. Users
can also access messages and attachments after logging on to the system.

To send a message

1. Click the Send a Message tab.

Messaging: Send Message

Send a Message | Contact Suppurt' Submit Feedback | Report a Problem

Enter the details of your message. Click Review to continue. The recipient list for this message has been saved, and you can add other
recipients at any time

* required entry
To (Email) *
(Clear Emails)

Separate emsil addresses with commas.

Message Subject *

Message *

Attach File Aftach File

Files will be attached to the system record and available for download from the system. A link to
download the file from the system will be included in the notification to the recipient. The file will not
be distributed by email or fax due to security restrictions.

Spell Check Clear All Clear Message

Review Cancel

In the To (Email) field, enter the user’s email address.

In the Message Subject field, enter the subject of the email message.
In the Message field, enter the message.

Click Review to verify your message.

6. Click Send to send your message.

vk wnN

You can also contact users from the search results page, on the contract audit summary page,
and from a vendor profile.

© B2Gnow Page 1-15
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Generating reports

The system has hundreds of standard reports and may include custom reports for your
organization. A complete list of these reports displays on the Reporting Tools: Report List
page. There are two types of reports, real time reports, specified with a v2 next to the report
title, and data dump reports.

Certified Directory ]

Business Revenues and Employees Three and five year average revenues and Add to Schedule
employee counts for each certified firm. Displays  Favorites Report
one or two year average if three years of

revenues not available.

w2 > Certified firms contracting vith other BE2Gnow List of all actively certified firms that have been Add to
oraanizations awarded contracts with OTHER organizations Favorites
M using the B2Gnow system.
Duplicate active certifications List of duplicated firms and certification types. Add to Schedule
Favorites Beport
v2 > Ethnicity & Gender Summary Summary of certified firms by ethnicity and Add to
gender on selected date. Favorites
W2 > Recantly Certifiad/Renswed Firms Firms certified and renewed in the date range Add to
selected; with contact information, one line per Favorites
firm.

Running reports

You can use the Reporting Tool to generate any of the reports available to you.

To run a real time report

1. Open the Reporting menu, and then click Full List.
2. Click the title of the real time report you want to run, which will have a v2 next to it.
3. Enter or select the options you want to use for the report. Options may differ between

reports.
£
Date Date Miew Report
Types ACDBE, DBE, M/DBE, MBE, PDBI| % Actions  |Expansion, New, Recertification/|| %

Threshold |90
(Days)

4. Click View Report.
The report displays in the browser window.

5. You can navigate between pages, change the magnification, search for specific text,
and print the report.

K 1 1 of 51 I Il 100% - Find | Next Select a format ¥ Export ﬂ =
Total Records 2208 B < 50 days
=80 days
<90 days >580days
Count: 1705 503
Percent: 77.22% 22.78%

6. To export the report into another forma, such as PDF, Excel, CSV, Word, or TIF, select
the format type from the Select a format list, and click Export.
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To run a data dump report

1. Open the Reporting menu, and then click Full List.
2. Click the title of the report you want to run, which will not have a v2 next to it.

Certified Directory

Business Revenues and Emplovess Three and five year average revenues and Add to Schedule
employee counts for each certified firm. Displays ~ Favorites Report

one or two year average if three years of
revenues not available.

w2 > Certified firms contracting with other B2Gnow List of all actively certified firms that have been Add to
organizations awarded contracts with OTHER organizations Fawvorites

using the B2Gnow system.

Duplicate active certifications List of duplicated firms and certification types. Add to Schedule

Favorites Report
¥2 > Ethnicity & Gender Summan, Summary of certified firms by ethnicity and Add to
gender on selected date. Favorites
¥2 > Recently Certified/Renewed Firms Firms certified and renewead in the date range Add to
selected; with contact information, one line per Favaorites
firm.

3. Select the parameters. Some reports require a date or date range, and all reports
have different output formats. You must select the desired output format at this time.

* required ent
Report Parameters @
Report Title * Contracts: Unresponsive Vendors

Report Description Unresponsive Vendors

Output Format * 7] Webpage (HTML)
(Selact one or mare)
V| Microsoft Excel (XLS)
Microsoft Access (MDB)
Comma delimited {C5V}

Run Report Return To List
Filter Parameters ?

Include Parameter Operator Value
Business Name Mone selected |Z|
Total Incomplete Lines None selected |Z|
Incomplete Prime Lines None selected |Z|
Incomplete Sub Lines None selected |Z|
Contact Person Mone selected |Z|

4. Click Run Report. It will be queued for processing and will usually complete within
two minutes.

Viewing reports

After running a data dump report, you can view it through the Report Output page. If the
report is available to view, the status displays as “Ready to view.” If the status is “pending,”
the report is not ready for viewing.

To view a report

1. Open the Reporting menu, and then click View Report Output.
2. Click the Ready to view hyperlink.
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List will automatically refresh once per minute. Raefrash List

Report Output

Date Date Date For

Last ;
Requested \, 25" Deletion

Report Status Actions

Contracts: Unresponsive Vendors Ready to view /11 9/18 Share
Extend Delste

3. Inthe Report Output Format area, click the View hyperlink for the format in which
you want to view the report.

* required ent
Report Parameters

HERETTE Contracts: Unresponsive Vendors
PR 2EEEEIIT Unresponsive Vendors
e
Report Output Format View Webpage (HTML)
View Download in Microsoft Excel (XLS) format
. “fou may need to first save, then open the XLS file from your hard drive.

Queue Report Again Share Report

There are several report output formats that are available. Not all formats are available on
every report.

Webpage (HTML)

The report output displays as a Web page. Some reports may display multiple tables of data.
Use this format to quickly view transaction and system information.

Adobe Acrobat (PDF)

The report output is formatted in a special report with tabularized and/or chart graphics. You
can save and email the report.

Microsoft Excel (XLS)

The report output is downloaded and displayed as a Microsoft Excel spreadsheet. You may
be prompted to open or save the file.

Comma delimited (CSV)

The report output is formatted in a manner that divides the data using commas. You can
open the results in a viewer (such as Microsoft Excel) or save the results to a .csv file (which
can be opened using Microsoft Excel).

Text (TXT)

The report output is formatted and output directly to a text file. You can open the report
results in a text viewer, or you can save the results to a text file. Use this format to download
data you can load into older database systems.

Custom Format

Some reports require specific output layouts, such as the FAA, FTA, and FHWA annual/semi-
annual reports. The calculated data displays in a form for review and editing.
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